Herts for Learning - Primary Computing Scheme

Upper Key Stage 2 – Information Models – Theme Guide
Children develop expertise in spreadsheets, using both formulae and functions. They import and analyse data collected
on data-loggers. They use conditional formatting to vary the format of cells and create tools for specific user needs.
They create models, identifying variables and using what-if modelling.
Learning objectives for the term
To understand that the spreadsheet structure enables us locate and change specific cells or ranges.
To understand that spreadsheets have a range of editing tools to support appearance and clarity.
To understand that spreadsheet calculation tools allow numbers and cell references to be used within formulae.
To understand that spreadsheet functions enable calculations to be carried out on ranges of numbers.
To understand spreadsheet functions help us analyse large data sets.
To identify opportunities for investigations involving data-loggers/sensors, and understand spreadsheet functions help us
analyse data sets.
To understand that the cells in a spreadsheet can be set up to change depending on the value being input. Develop to
include the use of =IF() statements.

To understand that tools can be designed using spreadsheet software to support different users’ needs.
To understand that spreadsheet models allow us to explore different situations in the wider world.
To understand that using graphs within spreadsheets can support prediction and ‘what if ‘questions.
On-going learning objectives
To understand the need for accuracy and efficiency in spreadsheet work. Save drafts. Use to improve their work.
To organise their work confidently in agreed locations, using appropriate file-naming conventions and folder structures.
To understand some of the methods they can use to report concerns about content and contact.

Vocabulary – see Glossary in main scheme document for definitions (for terms in blue)
Spreadsheet,
(spreadsheet) formula,
(spreadsheet) function
cells,
Selection (in programming)
columns and rows,
Variables (in spreadsheets)
cell reference

Possible resources for this theme (further resources are suggested with the explanatory notes below. Note that these
are examples and not formal recommendations.)
Spreadsheet Software
‘Data Sensing’ Apps
®
th
 Microsoft Excel
 Decibel 10 (iPad / Android)
®
 Google Sheets (as part of G-Suite for Education)
 iSeismometer (iPad / Android)
®
 Textease Spreadsheet
 Various Lux Meter apps, for measuring light
intensity (iPad / Android)
Data-Logging Hardware
 TTS Log-Box
 EasySense Vu
 LogIT Explorer
Please note that with any online platform it is essential that you review the privacy policy and terms and conditions of
the service. The school is responsible for the protection of data it holds and compliance with current data protection
legislation. Always assess both the data protection and safety of the service you are considering using, and ensure any
necessary permissions are in place before using with pupils.
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Primary Computing Scheme online materials that are referenced in this guide can be accessed from:
http://www.hertsforlearning.co.uk/user/login
You will need to be logged into your school account and have a current subscription to the Primary Computing
Scheme to gain access. The materials can be accessed from the My Resources link at the top/right of the
screen, once you are logged in.

Key learning objectives
(some objectives might be used for more than one lesson)
To understand that the spreadsheet structure of labelled sheets, columns and rows enables us to locate and change
specific cells or ranges.
 Before jumping in to functions and formulae, especially if pupils have had no previous access to spreadsheets,
start with activities that help them become familiar with the layout etc.
 It is essential that children understand the cell reference system in spreadsheets. You can use simple activities
to reinforce this. For example using cell references and colour-fill to create coloured designs, creating
spreadsheet treasure hunts, playing battleships on two sheets etc.
 Show children how a single spreadsheet file can have numerous sheets, and these are generally access from
tabs at the bottom of the screen.
To understand that spreadsheets have a range of editing tools to support appearance and clarity.


Allow pupils to experiment with the spreadsheet formatting tools, making cells larger, changing the cell border
colours and thickness etc. Use simple activities to develop confidence in moving around the spreadsheet and
changing the format and size of cells, rows, and columns.
 If pupils have not previously done this activity, you could use the pixel art activity described in the
accompanying sheet: [Using Spreadsheets to Create Pixel Art.]
 Practice entering different information into spreadsheet cells, e.g. text, whole numbers, decimals. Note the
format of the information entered.
®
®
 Then show pupils that the format of a cell can be changed. In Microsoft Excel this is done through the
Format Cells menu (right-click / Format Cells or use the Format menu in the Home tab toolbar.)
 Explore the formats available. What happens if you write a number into a cell with, for example, 3 decimal
places, and then format that cell to number with 2 decimal places? (The number will be rounded up/down.)
 Draw attention to the ability to format cells as currency (including the currency symbol you wish to use), date,
time etc.
 Pupils should become aware that information entered into a cell can then be accessed and edited from the
formula bar usually positioned at the top of the sheet. This is especially useful when functions or formulae have
been entered into a cell. In this case, the result of the function or formula can be seen in the cell, and the
function or formula that created the answer can be seen in the formula bar.
 Practise using ‘fill down’ and ‘fill across’ where the contents of cells can be replicated or a pattern followed by
dragging the cell downwards or across (usually from a small button at the bottom right of a selected cell / cells.)
®
 Experiment with adding images, SmartArt (if using Excel ) and using standard formatting tools to copy / paste
information etc.
To understand that spreadsheet calculation tools allow numbers and cell references to be used within formulae.







Build on the knowledge developed through the lower Key State 2 theme, Accuracy Counts. Begin by showing
that we can enter a calculation directly into a cell, beginning with an equals sign, and that calculation will be
made and the answer shown directly in the cell. The calculation (formula) that produced the answer shown in
the cell can then be seen in the formula bar, when the cell is selected.
Move on to using cell references and simple formulae for calculations. A formula performs calculations on
numbers within the sheet, using operators. E.g. =C4+D4 will add together the contents of the cells with the
references given. These are different to functions, which we’ll look at below.
Remind pupils that the symbols used for calculations in spreadsheets are slightly different from those we might
write:
o Divide is represented by a forward slash /
o Multiply is represented by an asterisk *
Create formulae with cell references for simple calculations, and then change the contents of the referenced
cells to see the answer change in the cell where the formula was written. We can therefore use spreadsheets
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to build useful tools to help us plan and predict in situations where numbers and calculations are used.
 As far as possible, link this use to maths so that there is a meaningful purpose to the activities / explorations.
 Thought-shower some examples of how we might use spreadsheets with simple formulae, for useful purposes.
Examples might include:
o Pocket money calculator. Using the spreadsheet to calculate how long it will take to save up enough
for a specific item.
o Times table machine. Quickly create the answers for any times table you like. See the accompanying
activity [Spreadsheet Times Table Machine Activity] available from the Primary Computing Scheme
downloads area.
o A tool for the kitchen staff to work out how many sausages they need to cook.
o Etc.
 Link to algebra if appropriate.
To understand that spreadsheet functions enable calculations to be carried out on ranges of numbers.
 Use functions for different calculations on sets of numbers, including:
o =SUM()
o =MAX() =MIN()
o =AVERAGE() =MEDIAN() =MODE()
 Functions use a pre-programmed word to perform calculations on a range of cells. We begin with an ‘equals’
sign, as with formulae, followed by the word (some examples above), followed by the cell references, in
brackets. E.g. =SUM(C4:C8)
 A colon is used to indicate the range. E.g. =SUM(C4:C8) will add together the contents of all the cells from C4
to C8, inclusive.
 A comma is used to indicate individual cells to include in the calculation. E.g. =SUM(C4, C6, C8) will add
together the contents of cells C4, C6 and C8 only.
 Commas and colons could be combined into one function. E.g. =SUM(C4:C8,C20:C25) will add together the
contents of all the cells from C4 to C8, inclusive, and the contents of all the cells from C20 to C25, inclusive.)
 Explore the effect of changing the number values to achieve specific targets.
To identify opportunities for investigations involving data-loggers/sensors, and understand spreadsheet functions help
us analyse data sets.
 This is a chance to use spreadsheets in meaningful explorations. Design and carry out the investigations using
data-loggers or sensing apps, linked where possible to science or geography.
 Some data-logging software, provided with the physical devices, allows data to be copied/pasted into other
®
®
programs, for example Microsoft Excel .
 Use spreadsheet tools, including functions and graphs to analyse the data and draw conclusions.
 Investigations could include, for example:
o Finding the ambient volume or light levels in different areas of the school, and then using a
spreadsheet to work out the mean and median readings.
o Which materials filter light most effectively? Use a light meter in a data-logger, together with a torch in
a darkened room, to record the light levels when the torch is shone through different materials such as
white paper, coloured paper, fabrics etc. Then use the spreadsheet to find and display in a graph the
maximum light intensity (therefore the poorest light filter,) the minimum etc.
To understand that the cells in a spreadsheet can be set up to change depending on the value being input. Develop to
include the use of =IF() statements.



Use conditional formatting in a spreadsheet to change the cell format depending on a condition, for example
changing the colour if a target is reached.
 In Excel, the Conditional Formatting menu in the Home tab toolbar, provides lots of options to explore, such a
highlight cells rules.
 Some children may be ready to write functions containing IF. See the accompanying video guide: [Using
Conditional Functions in a Spreadsheet] for a tutorial on writing your own conditional functions using the IF
function.
 The accompanying spreadsheet [Example Spreadsheet Model (School Fair)] contains conditional functions for
reference.
 Discuss how conditional functions are similar to selection in programming, where we use IF and THEN (and
sometimes ELSE) to program what happens if a condition is met. When writing your own conditional functions
using IF, we need to include what happen if the condition is met, and if it is not met (i.e. similar to THEN and
ELSE)
To understand that tools can be designed using spreadsheet software to support different users’ needs.
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Design calculation tools within a spreadsheet for others to use (for example
temperature/measurement/currency converters, multiplication tables, number lines/squares, pocket money
calculators etc.)
They should have the opportunity for their peers to try out their spreadsheet tools, who can comment on the
efficiency of the tool and how it might be further developed.
Before creating the tools in the spreadsheet, pupils should plan it on paper, thinking about the purpose of their
spreadsheet and the steps and calculations, functions and/or formulae that will be needed to make it work as
intended.

To understand that spreadsheet models allow us to explore different situations in the wider world.


By creating or using spreadsheet models, we can experiment with different sets of data to see what the
possible outcomes might be. They can therefore be very useful in a wide variety of situations.
 Show a ready-made spreadsheet model and discuss where similar models might be useful in the world
around us. Further examples might include:
o Creating a shopping list for a party, depending on the number of people that accept the invitation to
attend, and the budget available.
o Creating a budget sheet for a holiday.
o For a business to set the price of a product they are selling. They need to know how much profit they
will make if a certain number of units are sold.
o To predict the funds raised from a school summer fair.
 Children should understand there are key values in models, called variables, which can be changed to
influence final values.
 Provide ready-made spreadsheet models for pupils to experiment with, identifying and changing the variables
to see how the final values change as a result.
 An example spreadsheet model is provided in the additional resources download area. [Example Spreadsheet
Model (school fair)]
 Using the spreadsheet models, pupils can discuss the results, make hypotheses and then test these. For
example, using the water usage model suggested above, how much water could we save each day if we
showered for 4 minutes instead of 6?
To understand that using graphs within spreadsheets can support prediction and ‘what if ‘questions.


Create a simple model for a situation (for example the costs of a school trip). Identify the variables in their
model. Create graphs from the data and change variables to reflect different situations.
 In the school trip example above, you could use the spreadsheet model to explore the effect of changing
variables such as:
o Number of pupils going on the trip
o Cost of 3 different venue options
o Cost of meals
o Cost of travel per coach
o Etc.
in order to work out the cost for each pupil attending.
 Pupils present their conclusions.
On-going Learning Objectives
To understand the need for accuracy and efficiency in spreadsheet work. Save drafts. Use to improve their work.
To organise their work confidently in agreed locations, using appropriate file-naming conventions and folder structures.
To understand some of the methods they can use to report concerns about content and contact.
To understand the need to keep electronic and other data secure and protect personal information when entering data
online and to encourage eSafe practice in others.

Suggested independent task – any open-ended activity (2-3 sessions) enabling the children to demonstrate their
computing capability around the knowledge and understanding provided in the term
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Create a simple spreadsheet model to find possible answers to a real life problem.
Identify the variables within the model, explaining the effect of changing them.
Change the variables to provide a solution to the problem, presenting their answers in a report, using graphs as
appropriate.
Explain how the model helped provide solutions to the problem, justifying their choices.

Other considerations:
Does the task provide for children to work at different levels?
Is there support available for children to select if they wish?
Are there opportunities for the children to review and develop their work?
Is there an opportunity for the children to evaluate the finished task?
Demonstrating the knowledge the pupils have gained through working with the spreadsheet models above, in this task
they create their own model for a real situation, which you should specify. Ideas could include:
 A bus fare calculator so that the driver knows when he/she has to empty his fare machine.
 A pocket money calculator used in saving up for a games console.
 A tool for the school kitchen to work out what to buy for a school dinner, and the costs (not exceeding a given
maximum budget.)
 A profit calculator for a single stall at a school event.
 A profit calculator for the whole school event.
 Etc.
Pupils should accompany their spreadsheet with a written text identifying the variables, why they chose them and how
they use them within the model to make predictions and provide a solution. This could include graphs/charts copied
from the spreadsheet.
Please note there is an example medium term plan for this theme, donated by a Hertfordshire school, available to
download from the online area.
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